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Assalamualaikum Warahmatullahi Wabarakatuh and Salam Sejahtera, 

It is with great pleasure for me to write foreword for this “Workbook on Lean Healthcare Training: Step by 
Step Analysis using IBM SPSS for Emergency department and Medical ward”. Through Lean Healthcare 
implementation, Ministry of Health (MOH) has managed to eliminate wastes in the hospital processes, 
thus improving the quality of care to the patients. 

Since 2013, Lean Healthcare implementation expanded nationwide targeting the involvement of 
MOH hospitals at Emergency Department (ED) and Medical Wards (MW) in phases. As of 2017, a total 
of 52 MOH hospitals have been involved in implementing Lean Healthcare Initiative. Following the 
achievements in the Emergency department and Medical wards, MOH has expanded Lean healthcare 
initiatives to 10 hospitals with Orthopaedic and Ophthalmology specialist clinics in 2018 and later to 
other clinical disciplines in hospital. The progress of each Lean Healthcare initiative activities varies 
depending on many factors including leadership, strategy and teamwork of the staffs. Moving forward, 
implementation of services through better design and innovation in the Lean Healthcare initiative are 
key factors to ensure Lean Healthcare initiative sustainability.

I sincerely hope that this workbook will contribute in guiding hospitals who are involve in Lean Healthcare 
Initiative to work together towards a better service delivery to public. Let us all aim towards making the 
Malaysian Healthcare system as the best healthcare in the world.

YBrs. Dr. Hishamshah bin Mohd Ibrahim
Deputy Director- General of Health (Research & Technical Support)
Ministry of Health Malaysia

Foreword
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Assalamualaikum Warahmatullahi Wabarakatuh and Salam Sejahtera,

Lean Healthcare Initiative was introduced in Ministry of Health since 2013 using agile approach to reduce 
waiting time of patients and currently 109 hospitals have implemented Lean methodology at various 
areas such as Emergency Department (ED), Medical Wards (MW), Outpatient Department (OPD) and 
specialist clinics. Institute for Health Management (IHM) has been playing an active and direct role in 
introducing Lean Healthcare Initiative which is applied by each and every hospital.

Apart from the contribution in terms of training, IHM is tasked for the publication aspect related to Lean 
Healthcare initiative. We are publishing this workbook for Lean Healthcare training in order to share 
the steps of data analysis using IBM SPSS software to evaluate the performances of hospital in Lean 
Healthcare implementation at Emergency department and Medical ward. We hope that this module will 
serve as a reference and guidance on monitoring, especially for the present and future hospitals which 
implementing Lean Healthcare. Through the findings of these data analysis, we aim for the hospitals to 
be able to understand and improve congestion by reducing the waiting time. IHM aspires in being part of 
the Lean Healthcare Implementation team and assist in expanding Lean Healthcare initiative nationwide.

Finally, I would like to congratulate everyone who had been directly and indirectly involved in the successful 
publication of this workbook. It is hope that this workbook will be useful as a guide in implementation and 
monitoring of Lean Healthcare initiative. Thank you.

Dr Nor Hayati binti Ibrahim
Director
Institute for Health Management (IHM)
National Institutes of Health (NIH)
Ministry of Health (MOH)

Foreword
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Lean in Ministry of Health (MOH)

Introduction of Lean healthcare to Ministry of Health public hospitals started in 2013 with Hospital 
Sultan Ismail (HSI), Johor as its pilot hospital. Lean methodology focused on reducing waiting time and 
congestion at specialist clinic i.e. Orthopaedic and Oncology specialist clinic by eliminating any non-value-
added activities in the process. Following the implementation, improvement was seen with the reduction 
of 75% waiting time from first consultation until first treatment started at oncology clinic (1). Among 
the countermeasures are clearing backlog, increased machine utilisation, establish visual performance 
board to monitor patient flow and improve the clinic work process for better care to the patients.

As pilot project showed visible improvement within stipulated time, lean was expanded to Hospital 
Tengku Ampuan Rahimah (HTAR), Selangor with Emergency department (ED) and Medical Ward 
(MW) being the main focus as HTAR is known to be one of the busiest hospitals in Malaysia. These two 
departments were selected due to its congestion and longer waiting time experienced by patients. 
Emergency department are always at the frontline among the many services provided by the hospital. 
Year by year, the utilization of ED by the public has increased and this led to overcrowding. Not forgetting 
the Medical wards since most of the admitted patient will be under its care, MW receives around 33, 
002 number of admissions in a year and average of 91 patients per day (2). With the capacity of 1100 
beds in HTAR, bed occupancy rate (BOR) for Medical wards often exceeds 100%. With the introduction 
of lean methodology, the usual process in ED and MW was mapped using value stream mapping (VSM) 
and improvement was seen both in ED and MW. Average length of stay (LOS) reduced by 55% from 192 
minutes to 88 minutes and medical bed occupancy rate decreased from 144.7 % to 82.2 % for female 
ward within 6 months of implementation (2,3)

Following its success in both HSI and HTAR, the ministry has promoted the expansion to 133 public 
that hospitals started with ED and MW(4). The training was done by consultants from MITEC, UniKL 
during the earlier implementation stage and followed by Institute for Health Management (IHM). 
Until now, 109 hospitals including state, major and minor specialist hospitals have been trained in lean 
healthcare.

Figure 1: Lean Healthcare implementation expansion to 133 Ministry of Health public hospitals

BACKGROUND OF LEAN HEALTHCARE 
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The Approach of Lean Healthcare Training in MOH 

Lean healthcare training can be divided into three main stages with the implementation period involved 
minimum of 6 months. The stages are Stage 1; Training, Stage 2; On-site consultation and monitoring, 
and Stage 3; Analysis, reporting and presentation of report as seen in Figure 2. The participants were 
introduced to lean methodology during a three-day workshop at IHM which includes the development 
of current VSM and establishing the list of kaizen/improvements for their respective departments. Back 
in their respective hospitals, baselines data were collected and approved kaizen by the hospital Director 
were implemented. This will happen during Stage 2. After the implementation phase, the participants 
will enter Stage 3, where this stage is mostly for the confirmation of results and analysis of performance. 
During the early stage of implementation, the analysis is mostly done by IHM, however, as lean progresses 
further, there is a need in transferring the knowledge to the process owner. 

Figure 2: Overall approach of Lean healthcare training
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1.1 Descriptive statistics 

Data analysis is the process of gathering data systematically and converting it into useful information. 
Descriptive statistics are commonly used in analysing Lean healthcare data in SPSS because it is useful 
to summarise all the data by combining tables, graphs and statistical results to better understanding the 
analysis. Through descriptive statistic, it enables the user to describe the characteristics of the data or 
sample studied. Example of data includes demographic data such as age, gender, ethnicity, education, 
weight, height, income, education etc. Below are several components in descriptive statistics that can be 
used (5):

i.  Frequency distributions o 	 Calculate the frequency distributions by adding the 
number of data

ii.  Percentages, Proportions & Rates o	 Calculate the percentage by dividing the number of 
selected data by the total sample and multiply by 100. 

o	 Calculate proportions by comparing the subgroup of 
the study to the whole. Proportions can be expresses 
as a ratio

o	 Calculate rate by expressing number of observations in 
terms of unit of time or size of population

iii.  Presentation in figures o	 The use of histogram, line graph or scatter diagram to 
present data

iv.  Measures of central tendency o	 Used to describe the central position of a frequency 
distribution for group of data 

o	 Central tendency can only be used for numerical data
o	 These are mean, median and mode

v.  Measures of dispersion/spread o	 Provides information about the variability of the data 
o	 To describe the spread, a number of statistics are 

available, including standard deviation, range, 
percentiles and variance.

1.2 Overview on IBM SPSS interface

Statistical Package for Social Sciences (SPSS) is a statistical software used in statistical analysis for 
analyzing and displaying information using a variety of techniques. Due to its user-friendly features, SPSS 
are easily accessible by all skill levels and it can help in providing better results with minimal error. In lean, 
IBM SPSS software can be used to analyze our data (6,7).  SPSS can be divided into three windows: 

Table 1: Different windows in SPSS

Windows Suffix Function

Data editor .sav • can be divided into data view and variable 
view. 

• used to visualize, analyze and manipulate 
data.

Output viewer .spv • contains the result of any statistical procedure 
performed in data editor

Syntax editor .sps •  allow user to write commands that runs SPSS 
procedures

• enables user to perform task that is repetitious 
or difficult to do using drop down menus
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When opening SPSS, data editor and output window will be displayed by default. In data editor, there 
are two views; data view and variable view. The data view will display data for analysis (Figure 3). Users 
can also enter data manually in this data view. Variable view displays information about variables in 
the opened data (but not the data themselves), such as variable names, types, and labels, etc (Figure 4). 
Output viewer display the log of action taken in the analysis and the output. It consists of two frames; left 
side recorded log and right-side display result/output. 

Figure 3: Data view in data editor

Figure 4: Variable view in data editor
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1.3 Working with Data in SPSS 

In this lean data analysis, we will use:
a) File 
b) Transform
c) Analyze 

1.3.1 File 
> New 
	 If user wants to create new data, just click File > New > Data and it will open new empty screen. User 

can then add any data into it.  

> Open data 
	 In order to use SPSS, user has an option to open pre-existing dataset or create new data in the   data 

view. If user need to open pre-existing data, user can use go to File and click open. User can open Excel, 
Stata, SAS, CSV, tab-delimited without converting to SPSS data type. 

> Save and Save As data 
	 If user wants to save new entry in the dataset, just click File > Save. If the new additional data with 

different file name, user can use Save As tab. Just click File > Save As and new window will prompt you 
to input file name and intended location. 

1.3.2 Transform 

> Date and time wizards

	 This tab simplifies data associated to date and time values. In lean, data are usually in this format. User 

can click Transform > Date and time wizard. There are six options to be selected (Figure 5). 

a) 	 Learn how dates and time are represented - It provides a brief overview on date and time 
wizard.

b) 	 Create a date/time variable from a string containing a date or time - If you have a string variable 
in the form of date and time i.e. dd/mm/yyyy or hh:mm, you can change it to the exact date/
time format. 

c)	 Create a date/time variable from variables holding parts of dates or times - It allows user to 
create new date/time variable from the data.

d) 	 Calculate with dates and times - This option is used when user wants to calculate, either add 
or substract value from date and time. For example, user can calculate time duration using this 
option.  

e) 	 Extract a part of a date or time variable - This option allows you to extract part of a date/time 
variable, such as the day of the month from a date/time variable, which is in the form of mm/
dd/yyyy.

f) 	 Assign periodicity to a dataset - this option is used to create date/time variable with sequential 
dates.
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Figure 5: Date and time wizard

1.3.3 Analyze
This tab is use to analyse data for result or output.  In analyse tab, we will only use Descriptive statistics for 
this lean healthcare analysis. 

• Frequencies

This feature provides statistics and graphical displays useful for describing many variables. It will 
produce frequency table consists of frequency counts, percentage, mode, median, mean, standard 
deviation, variances, minimum and maximum value of intended variable. Output will be organized by 
variable where it has statistical table and frequency table for the variable. This can be used for both 
categorical and continuous variable. Frequencies can also produce histogram with or without normal 
distribution on the graph.

Figure 6: Frequency tab under Descriptive statistics
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Figure 7: Frequencies window

1. Variable(s): The variables need to be analysed using Frequencies procedure. You can add several 
variables to this box. 
2. Statistics: It contains various descriptive statistics mostly suitable for numeric variables. Most of 
these statistics are identical to the one in Descriptives, Compare means and Explore. The only exception 
is the Percentile values. It allows user to specify which percentiles to report. 

• Explore

Explore is best used to deeply investigate a single numeric variable, with or without a categorical 
grouping variable. It can produce a large number of descriptive statistics, as well as confidence intervals, 
normality tests, and plots. The Explore procedure produces detailed univariate statistics and graphs for 
numeric scale variables for an entire sample, or for subsets of a sample. User can select this function 
by clicking Analyze > Descriptive Statistic > Explore. A window will pop up and user need to select the 
intended variable and insert into dependent list box and click OK. 

Figure 8: Explore window
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1. Dependent list: the continuous numeric variables that user wishes to analyse. 
2. Factor list: this will produce individual summaries of the numeric variables with respect to each 
category (Optional)
3. Label cases by: ID variable with “names” for each variable. If not specified, SPSS will use the row number 
to label each data (Optional)
4. Statistics: Choices of statistic reports. Choices are Descriptives (by default), M- estimators, Outliers 
and Percentiles. 

1.3.4 Output

• Frequencies

Two tables will appear in the output window. Statistics will report the number of missing and non-missing 
data in the data set. Frequency table will contain four columns of summary measurement(8).
1. Frequency The cumulative number of data in each category.
2. Percent: The percentage of all data including both missing and non-missing data. 
3. Valid percent: The percentage of data in the category excluding the non-missing data. 
4. Cumulative percent: Total percentage of the data that has been accounted for up to the row. It can be 
computed by adding the numbers in the Valid percent column above the current row. 

• Explore 

Case processing summary will show how many valid data there were. The Descriptives table will have 
detailed descriptive statistics for each of the continuous variable, including skewness and kurtosis. 
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2.1 Preparation of Data in Microsoft Excel 

In Lean, data are usually collected using a prepared template for ED and MW (Appendix 1). This template 
was prepared during early stage of Lean implementation in 2015 with the aim to facilitate the hospitals 
in collecting data in a systematic manner. The data collector roles are crucial in making sure that the data 
collected are valid and reliable. If there is any problem with the data, data collection needs to be re-done 
again. 

Figure 9: Examples of rejected data collection form due to incomplete and invalid data

In Lean, data are usually collected in date and time format. Next, the data need to be entered and cleaned 
to eliminate any duplicates or missing value in Microsoft Excel prior to analysis in SPSS. User can refer to 
Table 2-3 for format of each data to be entered in Microsoft Excel. 

Below is an example of data entry in Microsoft Excel according to the given format (Figure 10). 

Figure 10: Example of data entry in Microsoft Excel
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Microsoft Excel is a good tool to enter any data and its format is compatible with SPSS. User can open any Microsoft Excel (.xls) 
file just by selecting the type of file from file type in SPSS. In Microsoft Excel, the data should be organised in one sheet, the first 
row should be the variable name i.e EDArvD, ConsT, Disposition and ArvBedD. Kindly make sure that the variable name can be 
easily read and contain no spaces. Underscore character can be used as a replacement for space. In this analysis, we will use the 
variables as shown in the table below (Table 2-3).

2.1.1 Emergency Department (ED) Variables

Table 2: Emergency department (ED) variables

No Variables 
(Excel/SPSS)

Format 
(Excel)

Format/Type 
(SPSS)

Label (SPSS) Value (SPSS)

1. HospitalID String Hospital ID Code

2. RN String Patient Registration no

3. EDArvD Date (dd.
mm.yyyy)

Date patient arrive at ED

4. EDArvT hh:mm:ss Date (hh:mm:ss) Time patient arrive at ED

5. ConsD Date (dd.
mm.yyyy)

Date patient receive 
consultation

6. ConsT hh:mm:ss Date (hh:mm:ss) Time patient receive 
consultation

7. DisD Date (dd.
mm.yyyy)

Date patient discharge from ED

8. DisT hh:mm:ss Date (hh:mm:ss) Time patient discharge from ED

9. Disposition Ordinal After patient seen by doctor at 
ED

1: discharge
2: warded

3: CNA

10. EDAdmitD Date (dd.
mm.yyyy)

Date ED doctor decides to admit

11. EDAdmitT hh:mm:ss Date (hh:mm:ss) Time ED doctor decide to admit

12. ArvBedD Date (dd.
mm.yyyy)

Date patient arrive on bed in 
ward

13. ArvBedT hh:mm:ss Date (hh:mm:ss) Time patient arrive on bed in 
ward

New Variables Created (Emergency Department)

14. ATC Date (hh:mm:ss) Arrival to Consultation - – USE 
SYNTAX / COMMAND

15. LOS Date (hh:mm:ss) Length of Stay – USE SYNTAX / 
COMMAND

16. BWT Date (hh:mm:ss) If BWT within 24 hours – USE 
SYNTAX / COMMAND

17. oneday ordinal variable to see if waiting time 
more than 24 hours– KEY IN 

MANUALLY ON DATA VIEW AS 
24:00

18. ATCnew Date (hh:mm) Arrival to Consultation new – 
USE SYNTAX / COMMAND

19. LOSnew Date (hh:mm) Length of Stay new - USE SYN-
TAX / COMMAND
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20. BWTnew Date (hh:mm:ss) BWTNew created if waited more 
than 24 hours.

21. ATCdatediff numeric Arrival to consultation date 
different for more than 24 hrs

0-Within 24 hours
1-After 24 hours
2-After 48 hours

22. LOSdatediff numeric Length of Stay date different for 
more than 24 hrs

0-Within 24 hours
1-After 24 hours
2-After 48 hours

23. BWTdatediff numeric Bed Waiting Time date different 
for more than 24 hrs

0-Within 24 hours
1-After 24 hours
2-After 48 hours

2.1.2 Medical Ward (MW) Variables

Table 3: Medical ward (MW) variables

No Variables 
(Excel/SPSS)

Format 
(Excel/
SPSS)

Type (SPSS) Labels (SPSS) Value (SPSS)

1. HospitalID String Hospital ID Code

2. RN String Patient Registration no.

3. DecDcD dd/mm/
yyyy

Date (dd.mm.yyyy) Date decision to discharge made by 
doctor

4. DecDcT hh:mm:ss Date (hh:mm) Time decision to discharge made by 
doctor

5. LeaveBedD dd/mm/
yyyy

Date (dd.mm.yyyy) Date patient leave bed

6. LeaveBedT hh:mm:ss Date (hh:mm) Time patient leave bed

7. BedCleanD dd/mm/
yyyy

Date (dd.mm.yyyy) Date bed cleaned & ready for next 
patient

8. BedCleanT hh:mm Date (hh:mm) Time bed cleaned & ready for next 
patient

New Variables Created (Medical Ward)

9 DT Date (hh:mm) Patient discharge from Medical 
Ward (within 24 hours) - – USE 
SYNTAX / COMMAND

10 oneday Date (hh:mm) Patient Discharged after 24 Hours

11 DTDateDiff ordinal Patient Discharge same day or 
different day/s - USE SYNTAX / 
COMMAND

0 – within 24 
hours

1 - > 24 hours

2 - > 48 hours

12 DTnew Date (hh:mm) Patient discharge from medical 
ward within 24 hours or more than 
24 hours -– USE SYNTAX / COM-
MAND

13 BTT Date (hh:mm) Bed turnaround time within 24 
hours – USE SYNTAX / COM-
MAND
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14 BTTDateDiff ordinal Bed Turnaround time on within 24 
hours or after 24 hours USE SYN-
TAX / COMMAND

0 – within 24 
hours

1 - > 24 hours

2 - > 48 hours

15 BTTnew Date (hh:mm:ss) Final data for BTT- USE SYNTAX / 
COMMAND

2.2: Importing data from Microsoft Excel to SPSS 

There are several methods to import data from Microsoft Excel to SPSS. Here, two options are provided 
for you to import your data to SPSS. 

2.2.1 Microsoft Excel to SPSS

Data can be import directly provided if the format is correct and cleaned properly from any duplicates 
and error. If the data is not yet formatted, user need to follow few steps before importing the data. 

Open the Microsoft Excel file (*.xls) and rename all the variables according to the variable name as in 
Table 2 and 3. 

Figure 11: Example of excel data after rename variable

Then, proceed with highlighting all the column containing time value and right click to change the cell 
format to 24 hours (hh:mm:ss). This applies to all columns with TIME format (Figure 12).

Right click and choose 
format cells

Figure 12: Format cells for column with time value
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Click the time format 
in 24 hours (hh:mm:ss)

Figure 13: Selection of the correct time format

After finish formatting, user need to close the Excel file first before opening it in SPSS. Step for importing 
data directly from Excel is as below:
In SPSS, click Open > File > Select the location of file > Select files of type to “Excel (.xls) > Select file > 
Open. 

Figure 14: Selection of type of files
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Figure 15: Example of file open directly from Microsoft Excel

2.2.2 Comma Separated Value (CSV) files to SPSS

Comma Separator Value is a delimited text file that uses comma to separate values.  Data stored in (.csv). 
Files with the extension .csv are called comma-delimited files; in this type of file, the observations are 
separated (or delimited) by a comma. CSV file stores tabular data (number and text) in plain text. CSV file 
are commonly used because many programs support the variations on CSV for data import. Alternatively, 
user can store data in CSV and open it using SPSS software (9).

Steps to import data using Comma Separated value (.csv) files type:

Open your file in Excel format. Save file in new files of type Save as > Save as type CSV- (MS-DOS). For 
Macbook user, save as CSV (Macintosh). After you have saved the file in *.csv format, close to Excel file 
(Figure 16). 

Figure 16: Save as CSV (.csv) file type
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Start by clicking File > Open> Data to open *.csv files in SPSS. The Open Data window will appear. In the 
Files of type list, the option “Text (*.txt, *.dat, *.csv)” is selected by default. Locate your file and click on it to 
select it, then click OK (Figure 17).

Figure 17: Open CSV file (.csv) type in SPSS

New window will pop-up showing Text Import Wizard. This window provides a preview of the data in 
your *.csv file. The next step is to indicate whether the data matches a predefined format, which would be 
a format saved from a previous *.csv file imported with the Text Import Wizard. In most cases there will 
not be a predefined format. Follow these steps in the Text Import Wizard to import the text data (Figure 
18).

Figure 18: Text import wizard for CSV file – Step 1
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If your data match a predefined format, click Yes and then browse for and upload the file that defines the 
format. (This would be the case if you had already imported a text data file into SPSS in the past that was 
formatted exactly the same way, and had chosen to save the import format during the last step of the Text 
Import Wizard.)

If your data do not match a predefined format, click No, then click Next.

Figure 19: Text import wizard – Step 2

If your data did not match a predefined format, you will need to tell SPSS how your data is formatted. In 
the “How are your variables arranged” area, click the button that matches your data’s format: Delimited: 
Variable values are delimited (or separated) in the file by a special character, such as a comma or a tab. 
Fixed width: Variables are aligned in fixed width columns. In the “Are variable names included at the top 
of your file” area, click Yes, then click Next (Figure 19).
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Figure 20: Text import wizard – Step 3

Click the buttons, and as necessary the values, that best describe your data for each of the following 
headings. If your dataset starts with a variable at first row/line 1, your data should begin at line 2. Click 
Next when you are finished (Figure 20).

In the “Which delimiters appear between variables” area, select the check box that reflects the delimiter 
used in your data. The delimiter is what is used to separate values from each other within the data. The 
options include Tab, Space, Comma, Semicolon, Other. If the text file is a .csv file, then the delimiter is a 
comma (Figure 21). 

If you do not know which delimiter is used in the text file, refer to document that is associated with your 
data or the data owner. 
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Figure 21: Text import wizard – Step 4

This step in Figure 22 allows you to specify the format for each variable in the data file. In the “Specifications 
for variable(s) selected in the data preview” area, SPSS explains that the default format selected for each 
variable. 

In the Data Preview area, SPSS displays a preview of how your data will appear in SPSS once the import is 
complete. You can select any of the variable names (columns) in order to alter the data format. Here, you 
can change the format of your dataset according to the intended format (Figure 22). 
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Select the format 
for variable

Figure 22: Text import wizard – Step 5

Finally, you can choose to save the file format that you just defined for the current data file in case you 
need to use it for future file importations. This file is known as predefined file. 

A preview of your data appears at the bottom of the dialog box. If you are satisfied with the way the 
preview looks, click Finish to finalise the import (Figure 23). 
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Figure 23: Text import wizard – Step 6

The modified file will appear in SPSS data view.

2.3 Data transformation and Analysis in SPSS

Data transformation is the process of converting data from one format to another; typically, from the 
format of a source to the required format. Before we can proceed with the analysis, we need to transform 
and create new variable for the original data set. The steps for data transformation are as below:

Select your file. Make sure the file type is in excel, otherwise the software will not be able to detect your 
file. Click Open > Variable view. 
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Select your file

File type 
in Excel

Figure 24: Opening Excel file in SPSS

Variable view 

Figure 25: Variable view in SPSS

In case the date is not displayed properly in the SPSS, copy and paste the data to the column in SPSS. In 
variable view, you can change the type to date format (dd.mm.yyyy) and time variables to date format 
(hh:mm:ss).
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Type

Change date 
format for 
date (dd.
mm.yyyy) 
and date 
(hh:mm:ss)

Figure 26: Change the type and format of data in variable view

The following instructions show a step-by-step example to transform data or variables for Emergency 
department and Medical ward. We need to create new variables before analysing  from the original data 
set.

2.3.1 Emergency department

2.3.1.1 Transformation data 

Example: 

Create New variable Þ Arrival to Consultation (ATC): duration of time from patient arrival until 
patient enters doctor’s room for consultation

Before analysis, ATC need to be created in the dataset since it is a new variable. By using the Transform 
tab, select Date and Time Wizard (Figure 27). A new window will appear as shown in Figure 28. 

Transform > Date 
and Time Wizard 

Figure 27:Choose Date and Time wizard under Transform tab.
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First, select Option 4 to calculate with dates and times and click Next.

Option 4 > Next

Figure 28: Date and Time wizard window

After selecting Option 4, proceed by selecting Option 3 to subtract two durations and click Next in step 
1 of 3 Date and Time wizard.

Option 3 > Next

Figure 29: Calculation on dates
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In order to calculate the difference between two durations e.g ATC, we need to select the required 
variables from our data. As shown in Figure 30, select Consultation date for Duration 1 and Arrival in ED 
date for Duration 2. Following that, click Next.

Consultation > 
Duration 1

Arrive in ED > 
Duration 2

Figure 30: Selection of variable for calculation of differences in date

Rename the result variable to ATC and variable label to Arrival to Consultation. Make sure the output 
format is in hh:mm. Then, select paste the syntax and click Finish.

New variable: 
ATC

Figure 31: Rename new variable as Arrival to Consultation
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Syntax window containing the command will appear. Highlight the command and click run selection. Your 
new variable, ATC will appear in the data view (Figure 32 and 33).

Figure 32: Syntax window with command for calculating date and time difference

Click run 
selection

Highlight 
command

Figure 33: Highlight the command and click Run

Right click at the ATC column and sort descending to view the outlier’s data. If there is a negative value, 
data owner MUST decide whether to remove or delete the data or check for any error in data entry 
(Figure 34). If there is an error in data entry, correction must be made by counterchecking from original 
data sheet. Once finished, proceed with the next step.
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Decide to delete/
change

Figure 34: Sorting the data to find any outliers data.

In variable view, right click at the empty row and choose insert variable. Named the variable oneday and 
change type to date with format hh:mm. Click OK.

Figure 35: Insertion of new variable – Oneday in the data set

In Data View, type 24:00 in the first line in column oneday. Then, copy and paste until the end of the row 
with data. Variable oneday is created to assist in the analysis process later and it refers to one day time 
duration which is 24 hours.
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Figure 36: Column oneday with 24:00 as time format

After finish creating new variable oneday, proceed with next step. Click Transform and choose Date and 
Time Wizard. Click Option 3 to calculate with dates and times and click Next.

Figure 37: Date and time wizard to calculate date and time

Then, in Step 1 of 3, click Option 2 to calculate the number of time units between two dates and click Next 
(Figure 38).



31

Figure 38: Calculation the number of time units between two dates

Select Consultation Date for Date 1 and Arrival Date for Date 2. MAKE SURE the unit is DAYS and choose 
option 1 (truncate to integer) for result treatment. Click Next.

Figure 39: Selection of variable to calculate difference between time

Rename the result variable to ATCdatediff and variable label ATCdatedifference. Select option 2 to paste 
the syntax into the syntax window. Click Finish.
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Figure 40: Rename the new variable

The new syntax for variable ATCdatediff will appear in the syntax window. Highlight the ATCdatediff 
syntax and click Run Selection. It will create new variable ATCdatediff in your data view.

Highlight and click 
run selection

New syntax for 
ATCdatediff.

Figure 41: Syntax for ATC date differences

The new variable ATCdatediff will appear on your data view in the form of number 1 and 0.
 
0 	is for data without any date difference.
1 	is for data with different in days (e.g arrive to ED 17 Aug 2016 2315 PM and consult doctor at 18 Aug 

2016 0030 AM).
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Figure 42: New variable ATCdatediff created in the Data set

Next, we will calculate the final value for ATC. Open the Syntax window and type the syntax below into 
the syntax window.

DO IF (ATCdatediff = 0). 
Compute ATCnew=ATC.
ELSE IF (ATCdatediff = 1). 
Compute ATCnew=ATC+oneday.
END IF.
MISSING VALUES ATCnew (LO THRU 0).
EXECUTE.
VARIABLE LEVEL ATCnew (SCALE).
FORMATS ATCnew (TIME5).
VARIABLE WIDTH ATCnew(5).
EXECUTE.

Highlight and click 
run selection

Figure 43: Highlight syntax and click Run to calculate the final ATC

Highlight and click run selection for syntax ATCnew. This will create the new variable ATCnew in the data 
view. This is the final value for ATC after calculation. We will use this variable to get the mean/average 
and throughput value.
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New variable 
ATCnew created

Figure 44: New variable, ATCnew in data set

2.3.1.2 Data analysis 

Arrival to Consultation (ATC)

We will analyse the data to obtain the average value for Arrival to Consultation (ATC). 
Click Analyze and then choose Descriptive Statistics and click Explore.

Figure 45: Descriptive analysis for ATC

Explore window will show interface as in Figure 46. Click ATCnew and insert into dependent list on the 
right side. In display section, choose Statistics. If you choose Both, the result will show both Statistics and 
Plot in Output window. Finally, click OK to proceed.



35

Click ATCnew into 
dependent list

Click Statistics

 
Figure 46: Explore window for further analysis

The result will appear in the Output window. The mean value is the average time for the Arrival to 
Consultation, ATC (Figure 47). In addition, you can also observe the minimum and maximum range for 
your data.

The mean value shown is 
the average time for ATC 
(e.g 1:16 = 1 hour 16 mins)

Figure 47: Descriptive analysis for Arrival to Consultation (ATC)- Average time

The next step is to find throughput value (e.g percentage patient being seen by doctor within 90 minutes 
for ATC), use the syntax provided in the syntax file. The syntax is as below:

DO IF  (XDATE.TIME(ATCnew) <= 1.5*60*60).
Compute Throughput_ATC=1.
ELSE IF (XDATE.TIME(ATCnew) > 1.5*60*60).
Compute Throughput_ATC=0.
END IF.
EXECUTE.
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Highlight the syntax and click Run Selection.

Figure 48: Paste the syntax to Syntax window

New variable named Throughput ATC will be created in your data view.  The data will be shown as 
1.00 = within 90 mins, and 0.00 = more than 90 minutes. Proceed with analysis by clicking Analyze > 
Descriptive Statistics > Frequencies

Analyze > Descriptives > 
Frequencies

Figure 49: Analysis for Throughput ATC using Descriptive statistics

The result will be shown in the Output window. Use the value provided in the valid percent column. In 
this analysis, the result interpretation will be summarised as 75% of patients is seen within 90 minutes.



37

The percentage of throughput 
can be obtained by looking at 
valid percent value of 1.00
 (e.g 1.00 = 75.0%)

Figure 50:Results of descriptive analysis in Output window

Repeat and follow these steps for other variable such as LOS (Length of Stay) and BWT (Bed Waiting 
Time). But this time you do not need to create the variable oneday again, as the same variable can be used 
for analyses. The new variables needed to be created is LOS, LOSdatediff, LOSnew, BWT, BWTdatediff, 
and BWTnew.

Call Not Attended (CNA)

The analysis of Call not attended (CNA) will be presented in the form of percentage value. The analysis 
will utilize the Disposition variable in the dataset (Figure 51). Begin the analysis by selecting Analyze > 
Descriptive Statistics > Frequencies (Figure 52)

Figure 51: Disposition variable was used to analyse Call not attended
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Figure 52: Frequency analysis for Call not attended

After Frequencies window appear, select Disposition in variable list on the left and click the arrow to 
bring it to variable box on the right (Figure 53). Next, click Statistics > click mean and standard deviation 
and click Continue and OK.

Figure 53: Selecting Disposition variable for analysis
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2) Click Mean and 
Standard Deviation

Click Statistics

Figure 54: Analysis for Frequencies

The result is shown in the output file as frequency table (Figure 55). Based on the example given, there 
are 27 number of Call Not Around (CNA) which equals to 4.1 %. Always see the valid percent column for 
results because it has excluded all the missing values in our data.

Figure 55: Result for Call not attended
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NOTE: Keep the syntax for future use. In case you need to analyse similar set of 
data again, you just highlight and run selection. However, this action is only possible 
IF the variable name is the SAME with the syntax. In case the variable is different, 
you still can use the syntax but you need to CHANGE THE VARIABLE NAME on 
the syntax.

Example: 

COMPUTE  ATC= Consultation - Arrival.
VARIABLE LABELS ATC "Arrival to 
consultation".
VARIABLE LEVEL ATC (SCALE).
FORMATS  ATC (TIME5).
VARIABLE WIDTH  ATC(5).
EXECUTE.

COMPUTE  ATC= ConsT - EdArvT.
VARIABLE LABELS ATC "Arrival To 
Consultation".
VARIABLE LEVEL ATC (SCALE).
FORMATS  ATC (TIME5).
VARIABLE WIDTH  ATC(5).
EXECUTE.
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2.3.2 Medical Ward

3.3.2.1 Transformation data 

Create New variable Þ Discharge Time (DT): duration of time from doctor’s decision to discharge 
patient until the time patient leaves bed (either going home/discharge lounge/referred to ward). 

Before analysis, DT variable need to be created in the dataset since it is a new variable. By using Transform 
tab, select Date and Time Wizard.  Then, choose Option 4 to calculate with dates and time. Next, click 
Next (Figure 56 and 57).

Figure 56: Transform data using Date and Time wizard
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Figure 57: Calculate with dates and time

Then, choose Option 3 to subtract two durations and insert variable LeaveBedT into Duration 1 and 
DecDcT into Duration 2. Click Next. 

Rename the new variable by typing DT on Result variable and type Discharge Time on variable label. 
Choose hh:mm:ss in the Output Format and click to paste the syntax into the syntax window and click 
Finish. Once the syntax window appears with the newly pasted syntax, highlight the item and click Run. 
The new variable, Discharge time will appear in data view (Figure 58-59). 

Figure 58: Rename the new variable, Discharge time
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Figure 59: Syntax for Discharge time in Syntax window

We need to check for outliers such as missing data, illogical data or any negative value before we proceed 
with the analysis. First, click column DT and right click to sort all the value ascending (Figure 60).

Figure 60: Sort all data in column DT to check for any discrepancies.

Once sorted, make a decision on each of the outliers either to delete or recheck again from original data 
source. If the negative value given is large number i.e -23:40, this might be due to the differences in date. 
Kindly proceed with the next step.

If the data consist of any negative value related to differences in date, we need to create new variable, 
DTDateDiff. First, click Transform and click Date and Time wizard. Select Option 4 to calculate with date 
and time (Figure 60) 
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Figure 61: Date and Time wizard to create new variable, DTDateDiff

Then, click Next and select Option 2 to calculate the number of time units between two dates and proceed 
with Next (Figure 61).

Figure 62: Step 1 of 3 in Date and Time wizard

Insert LeaveBedD variable in Date 1 and DecDcD in Date 2 area. Ensure the unit is in Days and select 
Truncate to integer and click Next (Figure 63).
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Figure 63: Step 2 of 3 in Date and Time wizard

Rename the result variable with DTDateDiff and variable label with a complete variable name. Finally 
select the option to paste the syntax into syntax window and click Finish (Figure 64).

Figure 64: Step 3 of 3 in Date and Time wizard

Syntax window will appear with the new syntax for calculation of date difference in discharge time 
(Figure 65).
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Figure 65: Syntax for DTDateDiff variable

Proceed by highlighting the syntax and click Run to execute the syntax. The result will appear as a new 
variable in data view.

Next, we will calculate the final value for DT. Open the Syntax window and type the syntax below into the 
syntax window.

* Date and Time Wizard: DTnew
DATASET ACTIVATE DataSet1.
DO IF (DTDateDiff=0).
COMPUTE DTnew=DT.
ELSE IF (DTDateDiff=1 & XDATE.TIME(DT)<=0).
COMPUTE DTnew=DT+oneday*DTDateDiff.
END IF.
MISSING VALUES DTnew (LO THRU 0).
EXECUTE.
VARIABLE LEVEL DTnew (SCALE).
FORMATS DTnew (TIME5).
VARIABLE WIDTH DTnew(5).
EXECUTE.

Highlight and click run selection for syntax DTnew. This will create the new variable ATCnew in the data 
view. This is the final value for DT after calculation. We will use this variable to get the mean/average and 
throughput value. 

Before proceeding to the analysis part, create new variable labelled “oneday” in the data set. Follow the 
same steps taken in Section 2.3.1.1: Transformation data for Emergency department data.



47

2.3.2.2 Data analysis

Discharge Time (DT)

We will analyse the data to obtain the average value for Discharge Time (DT).  Click Analyze and then 
choose Descriptive Statistics and click Explore.

Figure 66: Descriptive analysis for Discharge time

Explore window will show interface as in Figure 67. Click DTnew and insert into dependent list on the 
right side. In display section, choose Statistics. If you choose Both, the result will show both Statistics and 
Plot in Output window. Finally, click OK to proceed.

Figure 67: Explore window for analysis

The results will appear in the Output window. The mean value is the average time for DT (Figure 68). In 
addition, you can also observe the minimum and maximum range for the respective data.
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Figure 68: Analysis result for Discharge time

The next step is to find throughput value (e.g percentage of patients being discharge within 240 minutes 
for DT), by using the syntax provided in the syntax file. The syntax is as below:

DO IF  (XDATE.TIME(DTnew) <= 4*60*60).
Compute ThroughputDT=1.
ELSE IF (XDATE.TIME(DTnew) > 4*60*60).
Compute ThroughputDT=0.
END IF.
EXECUTE.

Copy and paste the syntax in the syntax window. Highlight and click Run to execute. New variable named 
Throughput DT will be created in your data view. The data will be shown as 1.00 = within 240 mins, 
and 0.00 = more than 240 minutes. Proceed with analysis by clicking Analyze > Descriptive Statistics > 
Frequencies (Figure 69).

Figure 69: Frequency analysis for Throughput DT

Proceed with the analysis for Bed Turnaround Time (BTT) and Throughput BTT by using the same step as 
Discharge Time. Kindly refer to Appendix 3 for all syntax.
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Appendix 1

Emergency deparment

Appendices

FRONT
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Appendix 3

1. Syntax for Emergency department 

NO. SUBJECT SYNTAX

1. Creating ATC
(Arrival to Consultation)

* Date and Time Wizard: ATC.

COMPUTE  ATC=ConsT - EDArvT.
VARIABLE LABELS ATC.
VARIABLE LEVEL ATC (SCALE).
FORMATS  ATC (TIME5).
VARIABLE WIDTH  ATC(5).
EXECUTE.

2. Creating ATCdatediff * Date and Time Wizard: ATCdatediff.

COMPUTE  ATCdatediff=DATEDIF(ConsD, 
EDArvD, “days”).
VARIABLE LABELS  ATCdatediff “ATCdatedif-
ference”.
VARIABLE LEVEL  ATCdatediff (SCALE).
FORMATS  ATCdatediff (F5.0).
VARIABLE WIDTH  ATCdatediff(5).
EXECUTE.

3. Creating ATCnew DO IF  (ATCdatediff = 0). 
Compute ATCnew=ATC.
ELSE IF (ATCdatediff = 1). 
Compute ATCnew=ATC+oneday.
END IF.
MISSING VALUES ATCnew (LO THRU 0).
EXECUTE.
VARIABLE LEVEL ATCnew (SCALE).
FORMATS  ATCnew (TIME5).
VARIABLE WIDTH  ATCnew(5).
EXECUTE.

4. Creating LOS
(Length of Stay)

COMPUTE  LOS= DisT - EDArvT.
VARIABLE LABELS LOS “Length of stay”.
VARIABLE LEVEL LOS (SCALE).
FORMATS  LOS (TIME5).
VARIABLE WIDTH  LOS(5).
EXECUTE.
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5. Creating LOSdatediff * Date and Time Wizard: LOSdatediff.

COMPUTE LOSdatediff=DATEDIF(DisD, 
EDArvD, “days”).
VARIABLE LABELS  LOSdatediff.
VARIABLE LEVEL  LOSdatediff (SCALE).
FORMATS LOSdatediff (F5.0).
VARIABLE WIDTH  LOSdatediff(5).
EXECUTE.

6. Creating LOSnew DO IF  (LOSdatediff = 0). 
COMPUTE LOSnew=LOS.
ELSE IF (LOSdatediff = 1). 
COMPUTE LOSnew=LOS+(oneday*LOSdate-
diff).
END IF.
MISSING VALUES LOSnew (LO THRU 0).
EXECUTE.
VARIABLE LEVEL LOSnew (SCALE).
FORMATS  LOSnew (TIME5).
VARIABLE WIDTH  LOSnew(5).
EXECUTE.

7. Creating BWT
(Bed Waiting Time)

* Date and Time Wizard: BWT.

COMPUTE  BWT= ArvBedT - EDAdmitT.
VARIABLE LABELS BWT “Bed waiting time”.
VARIABLE LEVEL BWT (SCALE).
FORMATS  BWT (TIME5).
VARIABLE WIDTH  BWT(5).
EXECUTE.

8. Creating BWTdatediff * Date and Time Wizard: BWTdatediff.

COMPUTE  BWTdatediff=DATEDIF(ArvBedD, 
EDAdmitD, “days”).
VARIABLE LABELS  BWTdatediff “BWT date 
difference”.
VARIABLE LEVEL  BWTdatediff (SCALE).
FORMATS  BWTdatediff (F5.0).
VARIABLE WIDTH  BWTdatediff(5).
EXECUTE.

9. Creating BWTnew DO IF  (BWTdatediff = 0). 
Compute BWTnew=BWT.
ELSE IF (BWTdatediff >= 1). 
COMPUTE BWTnew=BWT+(oneday*BWTda-
tediff).
FORMATS BWTnew(TIME6).
END IF.
EXECUTE.



56

10. Creating Throughput_ATC DO IF  (XDATE.TIME(ATCnew) <= 1.5*60*60).
Compute Throughput_ATC=1.
ELSE IF (XDATE.TIME(ATCnew) > 1.5*60*60).
Compute Throughput_ATC=0.
END IF.
EXECUTE.

11. Creating Throughput_LOS DO IF  (XDATE.TIME(LOSnew) <= 2*60*60).
Compute Throughput_LOS=1.
ELSE IF (XDATE.TIME(LOSnew) > 2*60*60).
Compute Throughput_LOS=0.
END IF.
EXECUTE.

12. Creating Throughput BWT DO IF  (XDATE.TIME(BWTnew) <= 2*60*60).
Compute Throughput_LOS=1.
ELSE IF (XDATE.TIME(BWTnew) > 2*60*60).
Compute Throughput_BWT=0.
END IF.
EXECUTE.

13. Analyzing ATC EXAMINE VARIABLES=ATCnew
  /PLOT NONE
  /STATISTICS DESCRIPTIVES
  /CINTERVAL 95
  /MISSING LISTWISE
  /NOTOTAL.

14. Analyzing LOS EXAMINE VARIABLES=LOSnew
  /PLOT NONE
  /STATISTICS DESCRIPTIVES
  /CINTERVAL 95
  /MISSING LISTWISE
  /NOTOTAL.

15. Analyzing BWT and Dispo-
sition

EXAMINE VARIABLES=BWTnew
  /PLOT NONE
  /STATISTICS DESCRIPTIVES
  /CINTERVAL 95
  /MISSING LISTWISE
  /NOTOTAL.

FREQUENCIES VARIABLES=Disposition
  /ORDER=ANALYSIS.

16. Analyzing ThroughputATC FREQUENCIES VARIABLES=Throughput_ATC 
  /ORDER=ANALYSIS.

17. Analyzing ThroughputLOS FREQUENCIES VARIABLES=Throughput_LOS 
  /ORDER=ANALYSIS.
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2. Syntax for Medical ward

NO. SUBJECT SYNTAX

1. Creating DT
(Discharge Time)

* Date and Time Wizard: DT.
COMPUTE  DT=LeaveBedT - DecDcT.
VARIABLE LABELS DT “Discharge Time”.
VARIABLE LEVEL DT (SCALE).
FORMATS  DT (TIME5).
VARIABLE WIDTH  DT(5).
EXECUTE.

2. Creating DTDateDiff * Date and Time Wizard DTDateDiff.
COMPUTE  DTDateDiff=DATEDIF(LeaveBedD, 
DecDcD,    “days”).
VARIABLE LABELS  DTDateDiff.
VARIABLE LEVEL  DTDateDiff (SCALE).
FORMATS  DTDateDiff (F5.0).
VARIABLE WIDTH  DTDateDiff (5).
EXECUTE.

3. Creating DTnew * Date and Time Wizard: DTnew
DATASET ACTIVATE DataSet1.
DO IF (DTDateDiff=0).
COMPUTE DTnew=DT.
ELSE IF (DTDateDiff=1 & XDATE.TIME(DT)<=0).
COMPUTE DTnew=DT+oneday*DTDateDiff.
END IF.
MISSING VALUES DTnew (LO THRU 0).
EXECUTE.
VARIABLE LEVEL DTnew (SCALE).
FORMATS DTnew (TIME5).
VARIABLE WIDTH DTnew(5).
EXECUTE.

4. Creating BTT
(Bed Turnaround Time)

* Date and Time Wizard: BTT.
COMPUTE  BTT= BedCleanT - LeaveBedT.
VARIABLE LABELS BTT “Bed turnaround time”.
VARIABLE LEVEL BTT (SCALE).
FORMATS  BTT (TIME5).
VARIABLE WIDTH  BTT(5).
EXECUTE.
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5. Creating BTTDateDiff * Date and Time Wizard: BTTDateDiff.
COMPUTE  BTTDateDiff=DATEDIF(BedCleanD, 
LeaveBedD, “days”).
VARIABLE LABELS  BTTDateDiff.
VARIABLE LEVEL  BTTDateDiff (SCALE).
FORMATS  BTTDateDiff (F5.0).
VARIABLE WIDTH  BTTDateDiff(5).
EXECUTE.

6. Creating BTTnew * Date and Time Wizard: BTTnew.
DATASET ACTIVATE DataSet1.
DO IF  (BTTDateDiff = 0). 
Compute BTTnew=BTT.
ELSE IF (BTTDateDiff = 1 & XDATE.TIME(BTT) <= 
0). 
Compute BTTnew=BTT+oneday*BTTDateDiff.
END IF.
MISSING VALUES BTTnew (LO THRU 0).
EXECUTE.
VARIABLE LEVEL BTTnew (SCALE).
FORMATS BTTnew (TIME5).
VARIABLE WIDTH BTTnew(5).
EXECUTE.

7. Creating ThroughputDT DO IF  (XDATE.TIME(DTnew) <= 4*60*60).
Compute ThroughputDT=1.
ELSE IF (XDATE.TIME(DTnew) > 4*60*60).
Compute ThroughputDT=0.
END IF.
EXECUTE.

8. Creating ThroughputBTT DO IF  (XDATE.TIME(BTTnew) <= 0.5*60*60).
Compute ThroughputBTT=1.
ELSE IF (XDATE.TIME(BTTnew) > 0.5*60*60).
Compute ThroughputBTT=0.
END IF.
EXECUTE.

9. Analyzing DTnew EXAMINE VARIABLES=DTnew 
  /PLOT NONE 
  /STATISTICS DESCRIPTIVES 
  /CINTERVAL 95 
  /MISSING LISTWISE 
  /NOTOTAL.
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10. Analyzing BTTnew EXAMINE VARIABLES=BTTnew 
  /PLOT NONE 
  /STATISTICS DESCRIPTIVES 
  /CINTERVAL 95 
11  /MISSING LISTWISE 
  /NOTOTAL.

11. Analyzing ThroughputDT DATASET ACTIVATE DataSet1.
FREQUENCIES VARIABLES=ThroughputDT
  /ORDER=ANALYSIS.

12. Analyzing ThroughputBTT DATASET ACTIVATE DataSet1.
FREQUENCIES VARIABLES=ThroughputBTT
  /ORDER=ANALYSIS.
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